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Cautions Before Starting

PwnNe

5.

Ensure the Emergency Stop Button is clear of obstructions and can be accessed easily

Check there is sufficient film on the roll to start printing

Check the waste bottle is not full

Check nothing has been left inside/on the printer which could obstruct moving parts or fall and
cause injury

Check service access covers are closed before power on

During Operation

1.
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10.

11.
12.

ALWAYS confirm there are no obstructions to moving parts of the machine before pressing
PRINT!

ALWAYS check nobody is working in the machine before pressing PRINT!

NEVER leave the machine unattended when printing

NEVER adjust film or cut finished transfers while printing

ALWAYS ensure the covers are closed when printing.

ALWAYS tie back hair and secure loose clothing when operating the machine

ALWAYS Pause printing if you need to leave the machine unattended for any reason

ALWAYS Pause the machine whenever you are adjusting the film

ALWAYS Pause the machine when cutting finished transfers to press

ALWAYS Shake the white ink for 10 minutes and leave to stand 10 minutes before pouring in to
tank

ALWAYS follow the end of day cleaning procedure and isolate the machine from mains power
ALWAYS Turn off the Curing Oven at the end of the day or when not in use

Tips Cautions and Warnings in this Operators Guide:

Tips: Advice on how to obtain best results from the equipment

Caution: A caution provides additional information, which if ignored may result in
equipment malfunction or damage

Warning: A warning provides additional information, which if ignored may result in a
risk of personal injury

WARNING Under no circumstances attempt service adjustments/Open service access
panels with the power ON or while the machine is Printing.
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Routine Maintenance

The DTF Magic 60PRO Printer is covered by a comprehensive on-site parts and labour
warranty, Post Warranty Service Support Packages are available.

However, to fully benefit from these provisions and ensure trouble free operation of
DTFMagic Pro and Finisher the following routine maintenance should be carried out according
to the schedule. Failure to carry out routine maintenance may damage your equipment,
invalidate warranty or make support chargeable.

Guaranteed Environmental Printing:
Temperature Range 15°C - 30°C (Celsius), | Relative Humidity range 50%-60%.

Ink Storage Conditions:
Temperature Range 5°C - 30°C | Relative Humidity range 40%-80%.

Tip: It is recommended the ink is acclimatised to the printing temperature and humidity,
before commencing any print.

Daily/Regular:
I.  When the printer isn’t being used (every 3-4 days).

Power the machine on and open DTF Magic Print software leave inks to circulate for
minimum 15 minutes. Perform two Strong Head Cleans followed by a Nozzle Check
repeat cleaning if Nozzle Check is no good.
After circulation and head cleaning operation, wipe down capping station and wiper
blade. Put a dozen drops of capping solution in the colour capping station and fully
Wet Cap the white capping station. Make sure head has homed and capped properly
before switching the power off and closing DTF Magic Print software.

Before each use:

I.  Confirm the waste bottle is not full, empty if necessary
Il.  Check there is sufficient ink, film and powder to start printing.
lll.  Always follow the Start-Up Procedure in this Operator Guide

After every use:

I.  Follow Running the Last Print Procedure in this Operator Guide
Weekly:

I.  If printing to File delete all print files from the DTF Printing Folder.

CAUTION: If HDD gets full, unexpected results from the RIP and DTF Magic Print software may
necessitate re-installation of the software to restore functionality
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Loading Film
Replacing/Loading film

1. Only loosen the RH Spool holder
2. Slide the spool holder to release the core

3. Remove outer packaging but leave the cling
film to protect it from dirt.

4. Confirm the film is coiled square

5. If necessary tap the end of the roll on the floor
or flat surface to square it up.

Confirm the wind direction of the new roll before installing.
Correct installation as indicated in the picture

Push the roll onto the LH spool holder in until it is tight.
Align RHS and slide inwards until it stops.
Tighten the clamp DO NOT OVERTIGHTEN

Remove the
protective film and
tape

Release Pinch Rollers
(Press Button)
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Loading Film

8. Pull film from the top of the roll and route it
under the tension roller A

9. Feed film under the pinch rollers B

10. Re-engage the pinch rollers press the Button

CAUTION: DAMAGE WILL occur the roller mechanism
if the pinch rollers are released with the manual
lever while the machine is powered!

11. From the front of the machine
12. Ensure film is under the silver guides on both
sides

13. Hold film and release pinch rollers using the
front Switch IMAGE 1

14. Align the film centrally on the platen IMAGE 2

15. Re-engage pinch rollers (Press button)

16. Feed 40cm onto the guide plate to ensure the
film doesn’t catch on the silver guide plates and
avoid any glue left from the securing tape

17. Recheck film alignment on the roll at the back
of printer adjust if necessary.

IMAGE 1 IMAGE 2

Notes:
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Start Up Procedure

Ensure Power switch ON

Twist the Emergency Stop button to power the
printer

Locate the circulation controls under the ink tanks on
the LHS of the machine.

Set the control knob between 30-40

Press the “White Ink Cycle” button below the knob.

Open DTF Magic Print software on the PC (icon on the
Task Bar).

Press “White Ink Cycle” button every 4-5 minutes for
at least 15 minutes.

If the DTFMagic Pro hasn’t been used for a prolonged
period extend the circulation time to 30 minutes
pressing “White Ink Cycle” button every 4-5 minutes.

o0
iy ©
Clean  Margin Left Perform head cleaning

2 head-All
2 head-H1

2hesd-iz  of |Cleanweak Click “Clean” > “Head All” > “Strong” repeat twice

Clean normal

Clean strong

Click “Check”

Confirm all nozzles in the test print are present to
avoid permanent damage to the print heads.

All colours and white should appear as in the
“Nozzle Status Print”.

If nozzles are missing return to STEP 3. Repeat Head
Status. If all nozzles fire across both Head Status
prints it is OK to start otherwise return to STEP 3.

STEP 4 Nozzle Status Print
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Start Up Procedure

Open DTF Magic RIP:

© Resolute RIP: R-Jet Pro DTF Color Fabric
File Queue Jobs Devices Tools View Help

; Importing Artwork
5 [N N |
) o olo G B |

R-Jet Pro DTF Color Fabric | R.Jet Pro DTF White Ink Only !

Click “Import File” button on the Quick Access Tool Bar

Navigate to artwork to be printed

Select file/s to be opened Click “Open” button

On Import the artwork will be print ready i.e. mirrored with a white
layer “underbase”

@ Queue Running

Name

PwnNE

—
100 200

| A — The file appears in the Imported Jobs List and a Print Preview is

E displayed.
1Rof %
Y Check the Print Preview is:
W 1. Mirrorede

2. Cropped to the edge of the image
3. Has no unwanted white areas in the image
4. s sized correctly

Print Ready?

To adjust/modify an image select it in the “Print Preview” or
“Imported Job List” panes

— A frame appears around the selected image

N T o Lomee peaa The original image is displayed in the attribute window
»ZDD.DDmn: s 119.i4mnv | 399.8 | Rotate v| F rOG . . Rk

b [ oo0m O[] oo Only the selected image will be manipulated
Colour Adjust J
Crop Mark Tnvert Reset

Tip: Once the artwork is imported, the aim is to nest/position it in the most economical way to avoid film
wastage as most of the cost in a DTF transfer is in the film.

The next few pages explain the different ways artwork can be cropped, copied, duplicated and nested to
achieve maximum film utilisation and get them Print ready.
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Start Up Procedure

Section 4 - Using Copies

Qlede’ Page | Job | [720x1800 Cotton Color

Crop... Duplicate...
ROARpdf 3

[ 20000ml & | [T] 119.94ml [N 3998 Rotate v ;:(Roor

Tennections Fer Lifs

-+ 000mmC Y 0.00mm J

Colour Adjust

Crop Mark Invert

720x1800 Cotton Color

ROAR pdf 3 2 (Duplicate)

= 72.730m ' &[] 200.00mnl 546,70 | Rotate vj }(Roar

LTennections Fer Life
o

Crop Mark

Connections For Life
CAannacrtinne Far | ifa

®KRoar
% Roar

Properties

Pattern Style: ! E E X \ 1. } =4 “' *l V Tl

[CJarea fil v v

Columns: 2% Xspadng:  [® 5.00mm S | 6.88% O

Rows: 15 Yspadng: . 5.00mm C 2.50%

> > Save ... Load ... Apply Cancel
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Using the Copy Function

A single click on the “Copies”
button steps and repeats the
selected image once, and
opens the rows and columns
boxes. Rows and Columns can
be changed using the arrow
buttons or the desired number
can be entered directly.

Double click “Copies” button
opens the “Modify Step and
Repeat” window.

The dotted line shows the
maximum printable width with
this particular image

Directly enter numbers in
columns and/or rows or use
the arrows to increment the
number of copies

Adjust “X” and “Y” spacing to
maximise space to cut out the

finished transfers

Click Apply



Start Up Procedure

couvuschiouz Loi rie -

When the width of film is utilised
with minimum waste enter the
number of rows required to
complete the order.

If it is not possible to utilise the
film economically try rotating the
image or see Section 5 Utilising

Duplicates

covuschouz oL el
COUUSLIoUR LOL 18 ;
KOQL}
covuschouz Lou s i
goat}
COUUSCHIOU LOL [
KOQL}

Koak}
X BOQLE

Koal}

Couvecliovz oL 4ell ©

goat]

couuschouz Lo ria i

X
X
X
\O
X
X

sk

)
i\
J

Example:

There are 7 images across the
film width. If the order is for 20
units, Entering “3” in the rows
U] PagEy b | [720x1800 Cotton Colr box, will result in 21 copies being

Copies... printed i.e. 1 spare.
ROAR pdf 3 2 (Duplicate)

2 7273om O [ @] [ mocom? 5wl mme ~ERoar W erint rReady?

"E 0.00 mm C |—+—| 0.00 mm C Lennections For Lifs ’ .
A s Go to Section 7 RIP & Print
v v Total Copies: 7

I soomm T F somm C
vt || et [

Section 5 - Using Duplicates

Sometimes, the size of the image, no
matter how it is rotated the thereis a
lot of film wastage.

CONUBC(IONZ LOL [146
COUNBCHIONZ LOk 16

This is where Duplicate may help
reduce wastage.

X
Nt

<£@;%
é%

ROAR.pdf 3

YD OH

ati | vod 2nocitasanal)

¢
:

72isogcotencoRr Click “Duplicate” button.
Duplicate... <
— = Ask for 1 “Independent” not “Clone”
T 5 5 4 duplicate click “OK”
= 200.00mel [ @ F] 11954l [ 399,65 Rotate ~ 3 Roar uplicate clic
== Lennecticns Fer Lifs

= 0.00mm % 0.00mmJ

Colour Adjust
Crop Mark
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Start Up Procedure

ROAR.pdf 4

D OH 3

lotid 101 2npitasnned

T OH 3=

otid vo1 enoitdsnned

T OH 3

otid vo7 enoitasnned

The duplicate file is brought in, Rotate
so one is landscape (horizontal) and
the other portrait (vertical).

With files in both orientations it may
be possible to adjust copies and
reduce wastage making better use of
the film.

COUWSCIOUE Ok [

Click “1” Page tab and “2” Nest All
button.

ikoa

N

e 7ooe
Section 1 - 550mm [ Multiple Content ] N
550mm Width: [550.00mm] |

Layout: Manual  ~ ...

ROAR.pdf 4

T OH 3¢

lotid oI enoitagnned

T OH 3¢

otid o enoitdanned

10 OH 3=

otid 0 enoitranned

COUECHIOUE Lok [1i8

KOQk

The RIP automatically “nests”
the images 5mm apart to make
best use of the film.

x

Print Ready?
Go to Section 7 RIP & Print

-~

(G Pooe
Section 1 - 550mm [ Multiple Content ] v
550mm Width: [550.00mm]

Layout: Manual v || ...
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Start Up Procedure

Section 6 - Nesting

&K °

COUUSCHIoUE oL

The RIP can automatically nest all imported
images with a default 5mm gap to make
economical use of the film. If small
quantities of transfers are required, the
option to nest images of different sizes in to
a single print job has advantages.

goa’

COUUBCJIoUE LOL [1§8 }
Couuecjioue LOL [1ie :—5

Y goat]

Couuscjloue oL e }—3
o

Koai|
Koai|

CouWeCHoUE LOL M8 }

=\

{
!
wene |

o PSSR

To do this:

1. Import the files to be nested

2. Set copies and orientation etc. (refer to
appropriate sections in RIP Basics get the
images “print ready”)

4
i

.E

‘@ ®
& =
o

il t
/ b =

Tip: Importing too many files makes the
resulting print file very large and increases
the time it takes to RIP.

w

Click on the 1 “Page” tab
4. Click on 2 “Nest All” button

The RIP automatically “nests” the images
5mm apart to make best use of the film.

Couuecjloue LoL [ie:
Couuscjioue oL I8

Koal

Couuscjoue LOL I8

% goak

| Print Ready?
= @, Go to Section 7 RIP & Print
=) , .
[T Tip: The RIP can automatically rotate
Q‘ individual images when nesting but “copies”
;;;] a are nested in the current orientation. If
|5 automatic nesting isn’t effective, try
changing orientation of copies and/or
manually nesting by clicking the image and
[SGueie] Pese [0 dragging it in the “Preview” pane. When
om e o] manually nesting the RIP allows images to
[ Lovout Manual [ placed less than the 5mm apart but doesn’t

allow them to overlap, to avoid overlapping
while manually nesting, drag images down
to make space.

Notes:
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Start Up Procedure

Section 7 - RIP & Print

Resolute RIP: R-Jet Pro DTF Color Fabric - 8 X
File Queue Jobs Devices Tools View Help

65 olo GO BHEDEDN YOG ERBES I

Ret Pro DTF Color Fabric 2] |_Fel Pro DTF Winte ik Only -l Pro DTF Black Knock Ot R et Pro DTF Colr Fabric_WIDE [1]. _Ret Pro DI Calor Fabc_DIRECT WS N V2 fomn S|
@ Queve Ruming _ total:2 0 £y 00 10 20 230 ;0 3 40 S0 S0 SS
Neme Status Prrt Mode Copies  JobCost _Fie Type Dimensions Substrae -
sx ROARpdf 32( ROARpdf ] 72011800 Catton Color 1 - POFfie 14545 mmx 400.00mm Nong ROAR.pdf 4 ROAR.pdf 3
Properties... Alt-Enter
#xx: ROARpdf 4 2 [ ROAR pdf | 720¢ otton Color 1 - PDF file 400.00 mm x 143.65 mm None

@
Remove Delete 3
Rename... E ®
Move selected jobs to 5
=3 L

Copy selected jobs to 5 4 =
otil vo 2noitosnnod

Create

b Xl
®
Amange 2 O
Print Alt+P @ o]
RIP Only Alt+S I C
Save As... b = ® g
» 2 ® b=
Generate Preview Image K & . . o
Replace rint ode. Properties... Alt+Enter otil vo znoitosnnod =
Convert to Raster § r'A_’
Spin/Rotate Job Remove Delete A V 9
Job Colour Replacement i
fects > Rename... l L) P
{ b '.\ N e
Easy Adjustments > . E 7 R
in2 : Move selected jobsto ¢ stil vod 2noitoennod
k Copy selected jobs to > E
Reserved
Name St
>
P ;" ROAR+label + Leavers Comg Create
It TAUP 2600 b MLPSD 2 Comg Arrange >
v
it TAUP 260 n0 bg XL PSD & Print Alt+P .
B SHEET11(1)+ SHEET 18(1)+ SHEET 1701 « SHERT 4(1) + SHEET 1(1)+ SHEET 10(1)+... Cond | [720¢1500 Cotton Color v
B % mper-sbag +jumper +socks Comg RIP Only Alt+S [ Jneme
= S A ROARpdf 32 (Duplicate)
: 454 CAST MEMBER BOLD AND SPACED 280mm x 70mm + RANCE CAPTAIN BOLD AND SPA... Comd aVe AS... In J None Fl i [was e [R] 0000l s T
55! Team Wofipack - magictouch x60p Cong Actions N J Nere #| | oL msmi o mmz
change education - magic touch x50.pdf Comd In JNm\e q | B 12 [M 1 Total Copies: 1
= X B soomn 0| soomm?)
360 Safety360 Red 30mm DTF pdf Comd Generate Preview |mage J None Fl e —
| 3 2l
Replace Print Mode...

Convert to Raster
Spin/Rotate Job...

Job Colour Replacement

Effects >
Production Plug-ins >
Easy Adjustments >
Mehdi 2 >

To RIP the job for costing purposes:
1. “Right” Click the image in the “Job List” pane
2. Scroll down and click “RIP Only”

The job will be RIP’d but not printed and will remain in the “Job List” pane

File Queue Jobs Devices Tools View Help

BWolo GRB BHEETIRD GO QG E=HHBE iz O

ro DTF Color Fabric [1] | R-Jet Pro DTF Whie Ink Only . _R.Jet Pro DTF Black Knock Out _ _R-Jet Pro DTF Color Fabric_WIDE [1]_R-Jet Pro DTF Color Fabric_DIRECT
Queue Running | total: 1/ holding: 1

3 Status Print Mode Copies  Job Cost = Dimensions Substrate
v ROAR + ROAR Holding [Job Spooled]  720x1800 Cotton Color

1
ROAR pdf 4 2 [ ROAR pdf | Holding [Job Spooled]  720x1800 Cotton Color
cx: ROARpdf 32 [ ROARpdf | Holding [Job Spooled]  720x1800 Cotton Color

1- The job total cost is displayed

2- “Click” triangle to get breakdown cost of each image in the job

3- Individual job costs displayed Note: This is a combined cost if there are copies
4- Number of copies in job

Page: 550.05 mm x 440.94 mm
400.00 mm x 143.65 mm

145.45 mm x 400.00 mm

LI

Tip: The cost price displayed covers the area of film occupied by the image, DTF Powder and Ink. It doesn’t include
any wasted film.
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Start Up Procedure

Section 7 - RIP & Print (Continued)

O e re R Rt pro DIF CotorTabne

File Queue Jobs Devices Tools View Help

150l ()8 B

SSDH

PO & &

0

Rolet Pro DTF Color Fabric [2} | RJet Pro DTF Whie lok Only._ BJet

Kaock Ot | Rlet Pro DTF Color Fabic_WIDE [1]. _R-et Pro DTF Color F

File

@ Queve Running | total: 2.
Name

oxs: ROARpdf 32[ROARpdf ]

Status.

Print Mode

Properties..
. ROARpdf 4 2[ROARpd |

Remove

Rename.

Create
Armrange

Print

RIP Only
Save As...
Actions

Spin/Rotate Job

AltEnter

Delete

Move selected jobs to >

Copy selected jobs to >

Alt+P.
Alt=S

Generate Preview Image
Replace Print Mode.
Convert to Raster

Job Colour Replacement

Notes:

Effects >
Production Plug-ins >
Easy Adjustments >
Mehdi 2 >
<
K
| Resenved
Name
» " ROAR +label + Leavers
b TAUP 2600 bg MLPSD 2
Mt TAUP 260 no bg XLPSD
B | SHEET 11(1)+ SHEET 18(1) » SHEET 17(1) + SHAET 4(1) + SHEET 1(1) + SHEET 10(1) =
B <. jumper +bag + jumper + socks
» (CAST MEMBER BOLD AND SPACED 280mm x 70mm + E CAPTAIN BOLD AND SPA.
{5 Team Wokipack -magictouch x50pdF
change education - magic touch x50 pdf
36 Safety360 Red S0mm DTF pof

\_, ueue

Jobs

Devi

ces

Copies
ton Color 1
ton Color 1

PO

Properties...

Remove

Rename...

Move selected jobs to

Copy selected jobs to

Create
Arrange
Print

RIP Only
Save As...

Actions

Generate Preview Image
Replace Print Mode...
Convert to Raster

Spin/Rotate Job...

Job Colour Replacement
Effects

Production Plug-ins
Easy Adjustments
Mehdi 2

Alt+Enter

Delete

Alt+P
Alt+S

L
]

m JNone A

4stil yod 2noitoennod

AiehjonanoﬂosnnOD

‘oY X

Hstid vod 2noitosnnod

[ o | [720x150 Gotion otr
Gopes..

ROARpdf 3 2 (Duplicate)

B sasml | @] ] w0.00ml [ 1095.5[ Rotwe

[ s0sssml () 000mm & -

E 12[M

T soomms E soomm s

Crop Mark Invert
L

13 Total Copies: 1

oY X%
X

stil vod 2noitoannod

To sen

d to Print either:

1. “Right” click the image in the “Job List” pane

2. Scroll down click “Print”
OR

3. Click “Print” icon on “Quick Access” toolbar
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Machine Minding During Operation

state

IMAGE A IMAGE B

IMAGE A IMAGE B
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Refill Ink Tanks when alarm sounds. A flashing light will indicate which ink is in a low

When refilling WHITE. The bottle MUST be shaken for 15 minutes and left to stand for
10 minutes BEFORE pouring in to the tank.

Monitor closely when the film runs low, DO NOT allow film to run out.

Monitor pre-fire lines ensure colours and white are
present and consistent “IMAGE A” If not pause and
perform 2 x “Strong” >“Both” head cleans wiping blade
between cleans.

When printing white only images some or all of colour
pre-fire lines can drop out, it is OK to continue printing
providing the white pre-fire lines are OK “IMAGE B”.
Before starting a colour job perform 2 x “Strong” >
“Both” head cleans wiping blade between cleans.

Ensure alignment is good “IMAGE A”. The “Choke”
should be a visible “halo” around the white.

If alignment is incorrect “IMAGE B”. In DTF Magic Print
software click “STOP” and press “Yes” to confirm.
Follow instructions “Alignment Procedure” section of
this manual.

INCREASING CURING TEMPERATURE

Images must be cured properly. Powder should be
melted and not look powdery.

If powder isn’t melted try:

Reducing the extraction to as low as possible without
smoke being visible

Either increase the “Oven Heat Setting” by 5°C (allow
temperature to stabilise before making further
adjustments).

OR

Increase the timer by 10 secs



Machine Minding During Operation

DECREASING CURING TEMPERATURE

If transfers appear brown or film is too wrinkled reduce
“Oven Heat Setting” By 5°C allow temperature to
stabilise before making further adjustment.

OR

Reduce the timer by 10 secs

If powder isn’t curing increase temperature as above

If transfers appear wet “sweating”. Either curing
temperature needs to be increased or reduce the amount
of White underbase in the RIP.

Check and empty the waste bottle regularly, an alarm will sound when it is about to
overflow. Dispose waste ink through the official recycling channels.

IT IS PROHIBITED TO DISPOSE OF WASTE INK THROUGH FOUL WATER DRAINS
(TOILET/SINK).

Notes:
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Shutdown Procedure

When the last print of the day is finished.

1. Move head to Left hand side use the
printer control panel left arrow button

|
|

o
o
°
°
.
®

2. Take 2 cleaning swabs and soak in
Cleaning/Capping Solution

3. Manually work the cleaning solution thoroughly
into each head. Use different swabs for colour
and white.

4. Clean any ink from the carriage assembly around
the heads using alcohol wipes and paper towel.
Take care not to touch the heads with either
wipes or paper towel.

5. Clean around the edges of the capping stations
with the swabs taking care not to cross
contaminate white and colour inks.

6. Finally clean the plate around the capping
stations and wiper blade with the swabs then
discard them.

7. Mop up cleaning solution from the edges of the
capping stations and surrounding areas including
the wiper blade with tissue paper.

—d
5
P %
glg)f

8. Use the alcohol wipes to remove any remaining
ink around capping stations and film guides
9. Dry/Polish with paper towel
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Shutdown Procedure

10. Put a small amount of capping solution in the
colour capping station until it is wet (Picture 1)

11. Flood fill the white capping station to the brim
with capping solution (Picture 2)

Picture 1 Picture 2

. Click “X Reset” Button in DTF Magic Print software

Right Ahead Back X Reset

. After the head has “homed” confirm the capping
station has contacted the heads

. Switch off Power Using Emergency Stop Button

. LEAVE Mains Power switch ON to circulate ink
when printer is not in use

. Shut down DTF Magic Print software

CAUTION: Failure to shut down DTF Magic Print
software may cause print settings to be lost.
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Alignment Procedure

1. In DTF Magic Print software open “Cross Test” file normally located in
c:\DTF Magic RIP\Print Data\Test Files

2. Setthe “X Copies” to 18.

3. Press Print.

The printed green crosses should appear as in the “Good Alignment” with the white
overprint centred precisely. A small “halo” of green should be visible on all the edges

Tip: slide a piece of white paper under the film to check alignment print

PET

360D

High ¥ Space: @
@® Horizontal Vertical

Left distance: | Print Adjust Print Verily Right distance: | Print Adjust Print Verify

Horizontal Alignment

To adjust the cross horizontally follow this procedure:

1. In DTF Magic Print software open 1. “ADJUST” Tab > 2. Select “HEAD SPACE” from the left hand Menu select
Horizontal

2. “A” values must be adjusted the same amount i.e. if the values are different, maintain the difference between
them. To move white cross left make “A” numbers more positive and to move right more negative. e.g. In the
example shown above the white cross needs to move to the left so the -1 number would be set to 0 in both
boxes. To move alignment right a figure of -2 would be entered in both boxes.

3. Print cross test pattern to confirm alignment.

4. If alignment is not perfect repeat Step 2 until alignment is perfect (See “Good Alighnment” picture above).

Tip: Increments of +1/-1 are best and repeat the cross test pattern to see effect

i}

Increase Value

o

) Vertical

e | Print Adjust

Reduce Value

Vertical Alignment

To adjust the cross vertically follow this procedure:

1. In DTF Magic Print software click on the 1. “ADJUST” Tab > 2. Select “HEAD SPACE” from the left hand Menu
select Vertical

2. To move the white cross up increase the “B” number to move down decrease it. e.g. In the example shown above
the white cross needs to move to UP so the 1463 number would be increased to 1464. To move down 1462 would
be entered.

3. Print cross test pattern to confirm alignment.

If the alignment is not perfect repeat Step 2 until alignment is perfect (See “Good Alignment” picture above).

Tip: Increments of +1/-1 are best and repeat the cross test pattern to see effect
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Calibration Procedure

Good Bi-directional Calibration Poor Bi-directional Calibration
If output transfers are blurred/fuzzy, check Bi-directional Calibration following the procedure below

DTFM © File & Print
0,

Pause Cancel

Print job list

n calibration_C A4 P1_ps...

Calibration Procedure

Click “ADJUST” tab

Click “BIDIREC ADJUST” from the left hand menu
Select Calibration print speed (Low/Middle*/High)
WARNING: Ensure nobody is working in the printer and
print head is clear of obstruction before clicking “Print
Adjust” Button

PwnNnpeE

* Default Print Speed
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Calibration Procedure

If calibration is good “0” Middle line will be straight and lines to the left and right will be progressively offset (as
above).

Positive

In the above example lines to the right of “0” get progressively straighter with line “18” being the straightest line.
Because the line is to the right of “0” it is -18 (lines to the left are positive numbers).

Dfmey ©File  @Print & sSetting In this example
B - -18 needs to be added to the existing number “Bidirect Value” box.

4
Check  Clean  Margin
IR— e.g. 8-18 =-10 “-10” need to be enetered in the Bidirect Value
X Print Dpi: ' 360DPI
Print Speed: [High

Head Install Print Speed: ngh
Step Adjust Bidirect Value: 8.00

Head Space Print Adjust
Color Adjust

Bidirect Value: 8.00

@ Bidirec Adjust

Print Adjust

If calibration is too far out no lines will be straight. Keep repeating the process
until “0” line is straight

Notes:
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RIP Basics

The following guide provides basic information to open, manipulate and
RIP artwork ready for printing.

For detailed information regarding all the supported RIP features click on
the “Compass” icon located on the “Quick Access” Tool Bar.

Resolute RIP: R-Jet Pro DTF Color Fabric

355 Gab BRCDED GO G

Ruet Pro DTF Color Fabrc [1] | Ret Pro DTF Whte Ink Only  RuJet Pro DTF Black Knock Out  Ret Pro DTF Color Fabric_HRes [1]
@ Gueve Running total: 1

|

Status. Print Mode. T I
Pendng 720x1800 Cotion Color - color chartRG8

L hessinwsed)
L L L]
H_EEEE
= o= -z S =
O
~DECEEEEN

L] | e =

EEEN. N
mE EE mEmEE
EEEmE .

L

lame Status
» CWG 50mm DTF +SandV 90mm + CWG 90mm DTF + SandV 54nm  Complete:
-

* ZENRIGHT + ZEN FRONT + ZEN LEFT + ZEN BACK + wimbledon  Complete.

GEORGEJARVIS2x12 Complete.

HARRYMOORE2x10 e 720x1800 Cotton Color

£ Footbal championship + Trapurko Crest Ssters Sports s ; crop.. Dupicate..

£ Power Shop + Trapunto Crest Sates Spts b + Bldo) e B

{ < Trapunto s G+ ik . .

& =] peprym - (5] Bl wmwwl[Ras tee v
. !

Cuiina Stobart 220 mm wide logo wth Pantone Ref ai L 0.00mm J Y 0.00mm &

Complete
G Y Colour Adjust

oo

RIP Main Screen
1. Quick Access Tool Bar
Queue tabs
Imported Job List Pane
Print Preview Pane
Image Manipulation/Job Attributes Pane
Job History Pane (held for 7 days as default)

ou A wWN

Resolute RIP: R-Jet Pro DTF Color Fabric .
Queue Jobs Devices Tools View Help Im porting Artwork

ol G B
R\HPmDTFCdorFabticb
@ Queue Running

Name

Click “Import File” button on the Quick Access Tool Bar

Navigate to artwork to be printed

Select file/s to be opened Click “Open” button

On Import the artwork will be print ready i.e. mirrored with a white
layer “underbase”

® N oW
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RIP Basics

The file appears in the Imported Jobs List and a Print Preview is
displayed.

Check the Print Preview is:
5. Cropped to the edge of the image
6. Has no unwanted white areas in the image
7. s sized correctly

Print Ready?
Go to Section 7 RIP & Print or:

To adjust/modify an image select it in the “Print Preview”
or “Imported Job List” panes

A frame appears around the selected image
— The original image is displayed in the attribute window

ROARpdf 3 1 1 H
T T Only the selected image will be manipulated

L coomn (Y o.oomm

Colour Adjust

& 2000ml [ &[] 119.94ml [N 39085 Rotate , }(Roqr

L tions Fer Lifa
+ 000mml Y 000mm{ A Sehneshans rer

Colour Adjust

Crop Mark

“Print Mode” Select for desired output/fabric

Original Artwork Preview

Rotation Tool (Instructions in Section 3)

Mirror Button - use only if the original artwork was already mirrored
Invert Button - creates a colour negative, black to white

Crop Mark - adds crop marks to artwork

Colour adjust options (Instructions in Section 1)

Image dimensions, scaling tools

. Copies - RIP Once step and repeat smaller file size (Instructions in Section 4)
10. Job Tab

11. Crop - opens cropping window (Instructions in Section 2)

12. Duplicate - opens a second instance (Instructions in Section 5)

©oONOU A WNE
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RIP Basics

Section 1 - Colour Adjust (Setting Choke/White Underbase/Colour Rendering Intent)

Queue Page = Job : 720x1800 Cotton Color

Copies... Crop... Duplicate...
ROAR pdf 3

[ 20.00ml [ @] [F] 119.94ml [N 300.8C [ Rotate +

. 000mmC Y 0.00mm

Colour Adjust

Y Easy Colour Adjustments

Layers Color Layer

Underbase

Maximum White Ink %

Strength | Strong 100% White under | v
Holes
[¥] Enable Ink Removal
Hole Size
No Ink 100% Ink
Vary hole size in areas of partial transparency

Transparency Hole Size 1.00

Bigger holes,  Smaller holes,
Lessink  Moreink

)( ROOI" Click colour adjust > opens Easy
e Colour Adjustments window

Select “Rendering intent”

ICC Setting = “Relative Colourmetric” with
Pantone Spot Colour Replacement

Photo = Best for Flesh Tones

Graphics = “Absolute Colourmetric” Best for
Company Logos and Graphics with maximum
vibrancy

Set Max white ink for “Underbase”
Default is displayed - Increase for stronger
whites under colours

Set “Choke” for artwork with fine lines

It is important that artwork has an amount of
white underneath it to provide sufficient ink for
the powder to stick to. If lines are 6 pixels wide

or less the choke will have to be reduced in

order to get some white printed behind them.

b Colour Adjust

“Colour Adjust” button in the “Job” tab is only available before image manipulation (Cropping/Copies etc.)
Adjustments made here only override Queue settings for the selected image.

“Colour Adjust” button in the “Queue” tab available after image manipulation (Cropping/Copies etc.),
Adjustments made here override Queue defaults for the entire job.

Colour Rendering Intent*
Choke*

White Underbase*

Ink Limit

Layer Intensity
Brightness and saturation
Maximum Ink

Tip: *It can be useful to illustrate differences in Rendering Intent, Choke and White Underbase for customer
acceptance. However, it is not good practice to make other colour adjustments in the RIP, for consistency these

adjustments should be made in original artwork.

(26]



RIP Basics
Section 2 - Cropping

QleuePage | Job | 7201800 Cotton Color

Copies... Duplicate...

ROAR pdf 3

B 20000ml | & [I] 119.94mnl 399.8:“Rotate v

+ 000mml Y 0.00mm

Colour Adjust

KRoar

Tennections Fer Life

Click “Crop” > opens cropping
window

Crop Mark Invert

© Tiling Setup

Disable all tiles

\Er = SRS

Defines the crop region

X: 6.75mm O

S Y: 8.26mm O
Width:  36.68mm

= Height: 13.10mm O

Click and drag the mouse to define a
CE crop region. Or with the cursor on a
3 crop line, press the shift key and

drag the mouse to move the line

15

I_QJ_JJQEI_&I]QIK)QDD_OQ _____

E Lot cick on the image to disable ties

Define ties

OBy rows and columns (® None Print overlap lines
(®) By dimensions O Tiling Overlap
O Manually OGaps

Height 30.00 mm O <

Width 50.02mm

Origin

[JRotate alternate columns

Reset

100

a&%q )« 1

)4 ya7 sl

GUlePage] Job | | 720x1800 Cotton Color

Copies... Crop...
[ RoARpdt 3 Tiel |
[ 146.67ml & | [T] s3.19mm C 399.8C | Rotate |
-+ o000mmC * 0.00mm

XKRoar

Tennections Fer Lifa

Colour Adjust

Crop Mark

To discard the cropped area click “Disable all
tiles”. “Enabling Tiles” crops images too wide
for the film retaining the cropped areas as
“tiles”, which are printed and can be joined
later when pressing.

Drag the cropping line to the edges of the
image
Click Create

Tip: work in Images saved as PDF or EPS
to remove unwanted boarders the RIP
always nests with a 5mm boarder.
Wasted film wastes money.

Once the image is cropped it can be
(if necessary) resized, copied and nested.

Print Ready?
Go to Section 7 RIP & Print




RIP Basics
Section 3 - Resizing

(& SOV D 33% v

400 500 600

0 100 200 300
"KAAJIIKAIIIIIJIA “‘.1‘]‘1.1 l'l]kikl[llll}hlll el
A
pofe)s B
L1 yad 2 rel ) 5
To resize an image simply type the vertical

or horizontal dimension in the required box
When the “padlock” is closed both X and Y
dimensions change maintaining the aspect
ratio.

Clicking the “padlock” unlocks it allowing X
and Y to be changed independently of each

300

GUEielTPage Job | [720x1800 Cotton Color v other.
Copies... Crop...
R 1 2 L |
r = i R—- N
= 20000ml & [3] 72737m T 546.7 | JRotate v /s\ROQr
~ A Tennectiens Fer Life
m ., 0.00mm .,
Colour Adjust

Covuscliouz oL pyell ©

% goat|

To make the most efficient use of the film
when the image is nested it may be rotated.
Select the image in the Print Preview pane
Click “Rotate” and select an angle of
rotation from the drop down selection.

Queve | Page | Job | 720x1800 Cotton Color

Copies... Crop...
[ ROARpdf 3: Tie 1
[ 146.67ml & | [T] s3.19mm T 39
{ 0.00mm C 7 0.00mm C

Colour Adjust

Crop Mark

Notes:
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RIP Basics

Section 4 - Using Copies

Queue Page ' Job 7' 720x1800 Cotton Color

Crop... Duplicate...
ROAR pdf 3

= 200.00ml & [F] 119.94mnl 399.33iRotate v] }{\Roar
-+ 000mmC Y 0.00mm

Zennections Fer Lifs

Using the Copy Function

Colour Adjust

Crop Mark Invert

A single click on the “Copies”
button steps and repeats the
selected image once, and

GUeeIFaey Job | [720x1800 Cotton Colr opens the rows and columns

boxes. Numbers can be

ROAR pdf 3 2 (Duplicate) entered manually.

= 72730m [Z] 200.00mal 546.ZCiF\'otate v: }(Roar
006 Ca —

Lennections Fer Lifs

Crop Mark

Double click “Copies” button
opens the “Modify Step and
Repeat” window.

The dotted line shows the
maximum printable width
with this particular image

Connections For Life
CAannactinne Far | ifa

% Roar

Directly enter numbers in
columns and/or rows or use
the arrows to increment the
number of copies

®KRoar

Adjust “X” and “Y” spacing to
maximise space to cut out the
Properties finished transfers

Pattern Style: ! s S >4 \
Click Apply

[CJarea fil

Columns: S o soommC | M 6.88%C
Rows: = soommC | F 250%
tal copies:

Notes:
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RIP Basics

Koatij

When the width of film is
utilised efficiently the job is
ready to RIP.

covusciouz Lot e -

covusechiouz LoL re

KoaL}

couvsciovz poL re i

KoaL}

couuschouz toL re i

goail,

COuusCIou2 LoL e -

Koal}

couvschouz Lo rye i

goail

couvecliovz oL yel ©

Example:
If the order is for 20 units,

“Copies” will be done in DTF
Magic Print software. This
keeps the RIP’d file size to a
minimum.

In the example 7 copies are
RIP’d so setting “Y Copies” to 3

720x 1800 Cotton Color in DTF Magic Print software,
Copies... will result in 21 copies actually

ROAR pdf 32 (Duplicate) being printed.
[~ 7273mm | & | [3] 200.00mal 546.mC ){ROO["

~ ~ Lennectiens Fer Lifs

0.00 v 0.00 v .

TE — rﬁ " Print Ready?
=) 1) |00 7 - Total Copies: 7 . .
T | s.00mm 2|2 | sc0mm Go to Section 7 RIP & Print

Notes:
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RIP Basics

Section 5 - Using Duplicates

g
8

Sometimes, the size of the image,
no matter how it is rotated the film
cannot be used economically.

COUNBCHIONZ LOL 146

”
.

CONUBCHOUZ Ok [148
Koail:

This is where Duplicate may help
reduce wastage.

-
-

10071’

ati | 103 ancitaenncl

W
B4
3

Click “Duplicate” button.
Ask for 1 duplicate click “OK”

ROARpdf 3

[ 20000ml & [T] 119.94mnl 399.8C | Rotate —,KRoqr

~ ~ Tennecticns For Lifs
- 000mmC * o0.00mm

Colour Adjust
Crop Mark

otid yo1 2noitasnned

1D OH 3

otil o7 enoitasnned

1D OH 3

atid vo1 znoitaenned

The duplicate file is brought in,
Rotate so one is horizontal and the
other vertical.

With files in both orientations it is
possible adjust copies to make
better use of the film reducing
wastage.

COUUSCIIOU Lok

Click “1” Page tab and “2” Nest All
button.

X

&

\
l

[ Gueve] Page [Job7]
Section 1 - 550mm [ Multiple Content ] =
550mm Width: [550.00mm] |

Layout: Manual | ...
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RIP Basics

Section 5 - Using Duplicates (Continued)

LGieie] Pace [cbT]

ROAR.pdf 4

YD OA 3

iatid 1o enoitasnned

1D OF 3¢

atid vo1 enoitaenned

T OH 36~

CouwsCHIoU? Lok 1B

% Koak

| otid 1o enoitaenned

Section 1 - 550mm [ Multiple Content ] ~

550mm

Width: [550.00mm]

Layout:

Manual v|| ...

Notes:

The RIP automatically “nests”
the images 5mm apart to make
best use of the film.

Print Ready?
Go to Section 7 RIP & Print
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Section 6 - Nesting

RIP Basics

COLUSCOUE EOL 45 —o

Koak|
Koai}

COUUSCHOUE LOL [{S }

of

‘abel

o

ceww

T mw
TN «

CouueCjoue LOL [is }
Couwscjoue oL [ie ;S
| ©

yoai|

Couuscjloue oL [iie ;

% goak}

goai

X

A
Laﬁvw
=
&
e
/

FEVAEBS

...

Couuscioue oL [iie

X goak

N B —
FEVAEB® -

Couuscjloue Lol e
Couvscioue oL [is

- KoaL
N poal

N

~NE —
TEYAEH@

Couvscioue oL [ie

Queue | Page | Job

Section 1 - 550mm [ Multiple Content ]

[ 550mm
[ Layout:

Width: [550.00 mm] v[

Manual v | ...

Notes:

The RIP can automatically nest all
imported images with a default 5mm
gap to make economical use of the film.
If small quantities of transfers are
required, the option to nest images of
different sizes in to a single print job has
advantages.

To do this:

5. Import the files to be nested

6. Set copies and orientation etc.
(refer to appropriate sections above
to get the images “print ready”)

Tip: Importing too many files makes the
resulting print file very large and
increases the time it takes to RIP.

7. Click onthe 1 “Page” tab

8. Click on 2 “Nest All” button

The RIP automatically “nests” the images
making best use of the film.

Print Ready?
Go to Section 7 RIP & Print

Tip: The RIP can automatically rotate
individual images when nesting but
“copies” are nested in the current
orientation. If automatic nesting isn’t
effective, try changing orientation of
copies and/or manually nesting by
clicking the image and dragging it in the
“Preview” pane. When manually nesting
the RIP allows images to placed less than
the 5mm apart but doesn’t allow them to
overlap, to avoid overlapping while
manually nesting, drag images down to
make space.
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RIP Basics

Section 7 - RIP & Print

Resolute RIP: R-Jet Pro DTF Color Fabric e
File Queue Jobs Devices Tools View Help
S > RN I T T o
boolo GEE BEHRBIB®DN GO G =R d
R-Jet Pro DTF Color Fabnc [2] |_RJet Pro DTF Whie Ink Only._R.let Pro DTF Black Knock Out__Rhlet Pro DTF Color Fabic_WIDE [1] _RJet Pro DTF Color Fabric_DIRECT u % S{ > Y To width v
@ Gueue Running | total: 2 0 50 100 150 200 250 300 350 400 450 500 5
Name Status Print Mode Copies  Job Cost Fie Type Dimensions Substrate " - A
v ROARpdf 32 [ROARpdf | 720x1800 Cotton Color 1 = PDF file 145.45 mm x 400.00 mm _] None. E ROAR.pdf 4 ROAR.pdf 3
Properties... Alt=Enter
o ROARpd 4 2[ROARpdt | e Dete 720agaton Color 1 : PDFfle  40000mmx 14365mm _JNune 8 V
Rename... ®
Move selected jobs to > L : ® ®
Copy selected jobs to > = ® S ® ®
e K atil yod 2noitosnnod
Amange > g O
Print Alt+P (J (o]
RIP Only AltsS lo g
Save As... & ® b=
Actons > 1 o
2 ® =
Generate Preview Image i & . N o
Replace rint Mode.. Properties... Alt+Enter otil vo 2noitoennod c
Convert to Raster g Q0
i i
; Remove Delete a V o
Job Colour Replacement g L
Effects > Rename... B ) r P
Production Plug-ins > L ﬂ ] (2]
Easy Adjustments > . = z 2
2 ; Move selected jobs to i’ stil yod 2noitasnnod
< - > 2
Copy selected jobs to > 8
Reserved 47]
Name Stat Substrate P |o
> 5
> 5" ROAR+label + Leavers Comg Create b [t #l
LNt TAUP 2600 bg M-LPSD 2 Comd Arrange > b _I None Fl o
& v
[l TAUP 2600 bg XLPSD oy Print Alt+P (e —
» : SHEET 11(1) + SHEET 18(1) + SHEET 17(1) + SHI 4(1) + SHEET 1(1) + SHEET 10(1) ... Comg hm Jane Fl Queve Page Jﬂbu 720x1800 Cotton Color v
B i3, jumper + bag + jumper-+ socks: Cond RIP only Alt+S b J None Fl Copies.es
s S A d F?)V‘.RMJZQD!D\N:BM) - .
: 5% CAST MEMBER BOLD AND SPACED 280mm x 70mm + RANCE CAPTAIN BOLD AND SPA... Comd aVe AS... In J"hﬂ? il [wsa ey [R] T [000ml wss‘:iﬁma\e N
55 Team Wopack - magictouch xS0pd Cong Actions N Jum f :[ m,ﬁmz = ammz
change educaton - magi touch x50k Cong 3 J wone F | E 1S 1.C| Total Copies: 1
- i W som s E soom s
360 Safety360 Red 90mm DTF pof Comg Generate Preview Image _I None Fl ‘c’wm‘k hm EI
| i 2kl
Replace Print Mode...
Convert to Raster
Spin/Rotate Job...
Job Colour Replacement
Effects >
Production Plug-ins >
Easy Adjustments >
Mehdi 2 >

To RIP the job for costing purposes:
3. “Right” Click the image in the “Job List” pane
4. Scroll down and click “RIP Only”

The job will be RIP’d but not printed and will remain in the “Job List” pane

(]

File Queue Jobs Devices Tool

s View Help
oo GRB BB YO G @ %

Pro DTF Color Fabric [1] |_RaJet Pro DTF White Ink Only __R-Jet Pro DTF Black Knock Out . R-Jet Pro DTF Color Fabric_WIDE [1]_R-Jet Pro DTF Color Fabric_DIRECT

Status Print Mode Copies 0 il Dimensions

ROAR + ROAR Holding [Job Spooled] 720x1800 Cotton Color @ Page: 550.05 mm x 440.94 mm

ROARpdf 4 2 [ ROAR pdf | Holding [Job Spooled] 720x1800 Cotton Color & 400.00 mm x 143.65mm

sx: ROAR pdf 32 [ ROARpdf | Holding [Job Spooled]  720x1800 Cotton Color . 145.45 mm x 400,00 mm

5- The job total cost is displayed

6- “Click” triangle to get breakdown cost of each image in the job

7- Individual job costs displayed Note: This is a combined cost if there are copies
8- Number of copies in job

Tip: The cost price displayed covers the area of film occupied by the image, DTF Powder and Ink. It doesn’t include
any wasted film.
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RIP Basics
Section 7 - RIP & Print (Continued)

| I e —— B X
File Queue Jobs Devices Tools View Help o
N L = =
353 Y(WB BlNPDNEN GO G & .
RJet Pro DTF Color Fabric 2] |_Rolet Po DTF W ok Oy Rolet P Kook 0| R el Pro DI Cole Fabec WIDE 1], Ret P DT Concranl |- || & Queue Jobs Devices T HE[‘, e I}
| @ Queve Ruming | total:2 , e~ 0 s
Name Status. Print Mode Copies M 1
. ROARpdf 32[ ROARpdf | ton Color 1 ’ H ‘ ‘ \ 2
Properties... AlteEnter | & N {—q - -
. ROARpdf 4 2[ ROAR pdf | 720 tton Color” 1 | ———
b osee | _O > % I N\TR
Move seectedjobs to > =
Copy selected jobs to > | = < » 1
Crate | otil vod 2noitosnnod
s ; 1 Q
Print Altsp ® (o]
RIP Only Ates | i V | E
T N npeo ) | 8
Generate Preview Image | N L @ | -*5
Replace Print Mode. | Properties... Alt+Enter stid vod 2noitasnnod | g
Convert to Raster E
| § |
Spin/Rotate J Remove Delete 2 @ ‘ Q i
Job Colour Replacement 5 ¥
fects > | Rename... " [ r =
Production Plug-ins > B - 1 m
e Spstments iq Move selected jobs to > N
Bl > : stil yod 2noitosnnod
F Copy selected jobs to > 2z
Reserved T
Name Staty Creﬂte > Substrate Lid §7
B ;" ROAR«label+ Leavers Cond I JNene Al
Wil TAUP 260no bg M-LPSD 2 Comd Arrange > J None Fl 2
@ v
Lt TAUP 2600 bg XLPSD Comg Print Alt+P b [ Jrene A
B | SHEET 11(1)+ SHEET 16() + SHEET 17(1)+ SHAT &(1) « SHEET 1(1) « SHEET 1001+ .. Cond b [ ] vone 7 [GSEICERGE  | (72001800 cotton color v
> 32, jumper + bag + jumper + socks. Com R[p On[y Alt‘,s L J Noview El Coples...
Save As". ROAR pdf 3 2 (Duplicate)
: 2 CAST MEMBER BOLD AND SPACED 280mm x 70mm + BANCE CAPTAIN BOLD AND SPA... Comg In JN«\; Fl B l~)5,45mn: @ II 4OD.Dﬂmn: 1093.:7Rmae 3
53 Team Wolipack -magitouch x50pdt Conf Actions > J Nore F| | <[ oxssm? ¥ o0omm s
change education - magic touch x50 pdf Cond b J None Fl E £ U 1 Total Copies: 1
368 Generate Preview Image ] ¥ somm 0 F soomn T
%% Sefety360 Red S0mm DTF pf Com None Fl
o | e
Replace Print Mode... —
Convert to Raster
To send to Print either:
Spin/Rotate Job... “p: IRT . . « s an
4. “Right” click the image in the “Job List” pane
Job Colour Replacement . Up i g
¥ 5. Scroll down click “Print
Effects > OR
Production Plug-ins >
H “ H v/ “ H ”
Eay AuBETe , Il 6. Click “Print” icon on “Quick Access” toolbar
Mehdi 2 >

Notes:
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